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Introduction 

 

Oasys Pile, Alp, AdSec and ADC are programs that analyse single piles. The input wizards enable 

the quick generation of complex staged construction sequences. The outputs are designed to 

help the user examine relevant results, as well as visually communicate these results to clients. 

The calculation itself is based on verified and robust numerical methods and the simplicity of 

calculation enables new users to set up and run problems within hours of completion of this 

tutorial. 

The various tutorial examples deal with a range of practical pile analysis but this Tutorial Manual 

is intended to familiarise the user with the programs. The examples should therefore not be 

used as a basis for practical projects. 

Users are expected to have an understanding of soil mechanics and geotechnical theory, and 

should be able to work in a Windows environment.  

It is important to realise that Pile, Alp, AdSec and ADC advanced programs and the user must be 

fully aware of the various methods of analysis, requirements and limitations discussed in the 

User Manuals before use. The Tutorial Manual will not provide theoretical background 

information on the analysis method, nor does it explain the details of various methods of 

analysis available in the programs. These details can be found in the User Manuals. This also 

contains detailed information on the available program features.  

Short courses are also regularly organised and should you be interested in more hands-on 

experience you can contact oasys@arup.com for dates and program content. 

  

mailto:oasys@arup.com
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Section 1  

Step-by-Step Tutorial 1  

Oasys Pile – Pile Capacity and Settlement Analysis 

Objectives 

By the end of the session the user should be able to: 

 Navigate the Pile Interface 

 Input Capacity and Settlement Data 

 Run an analysis 

 Navigate the Graphical Output 

 Create simple graphs 

 Export tabular outputs for further analysis 
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1.1 Components of the User Interface  

The principal components of Pile's user interface are the Gateway, Table Views, Graphical 

Output, Tabular Output, toolbars, menus and input dialogs. These are illustrated below. 

 

Hint: When using the Gateway, click ‘+‘ to expand an item. Double click on the item to open the 

corresponding window 
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1.2 Pile Capacity Analysis 

1.2.1 Creating the input 

 Once opened, create a new file by clicking the ‘New File’ icon on the top left of the 

program or clicking Ctrl + N 

 Fill the Titles and Units dialog box: 

  

Hint: Should the user need to change the Units, they should do so at this point by double clicking 

on Units in the Gateway 
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 Double click on Analysis Options in the Gateway.  

 Select Capacity and the following options: 

 

 Double click on Capacity Data in the Gateway 

 Select the Working Load Calculation Method and click OK 
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 Choose the following options:

 

 Double click on Pile Properties in the Gateway 

Select a Solid Pile without under-ream, E = 20 000 000 kPa 

Select the inputs to calculate the Pile Capacity between 5m and 35m below ground level, 

calculating the values every metre 

Input Pile Diameters of 600mm and 700mm. 

Hint: Move onto the next line in the input table to store the previous values inputted 
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 Double click on Material Properties in the Gateway 

 Define materials which make up the soil profile around the pile. 

 

 Specify Nq for Material #1 as 50. 

 

 See the help file for instructions on how to set the limiting value of end bearing to ‘unlimited’. 
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 Double click on Soil Profiles in the Gateway 

 Define layers constituting the soil profile around the pile:  

o top of Layer 1 at 8mOD 

o top of Layer 2 at 0mOD 

o top of Layer 3 at -25mOD 

 

Note: The tab at the bottom of the table shown below allows the user to enter more than one 

soil profile, should they wish to compare the impact of different soil properties or stratigraphy 

boundaries 
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 Double click on Groundwater  in the Gateway 

 

 To define a hydrostatic pore-water distribution, just define the level of the phreatic surface.  

 For this example, input the two phreatic surfaces for the soil profile to compare the impact of 

dewatering around the pile: 

 Groundwater Profile 1:  6 mOD 

 Groundwater Profile 2 : 0 mOD 

Hint: Use the tab at the bottom of the table to input two different groundwater profiles 

 Double click on Soil Profile – Groundwater Map in the Gateway. 

 Assign the inputted soil profile to Groundwater Profile 1. 

Note: This feature allows the user to analyse the impact of different groundwater levels on the 

soil stratigraphy in one file. Once the analysis has been run for one profile, the file can be 

reanalysed to compare results 
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1.2.2 Analysis and Outputs 

 Prior to analysis, check all inputs and save the file 

 Click on the analyse button to carry out the analysis 

 The solution progress window will automatically appear and the analysis will run. 

1.2.2.1 Tabular Outputs 

The program will give the user the option to view tabular inputs and outputs. 

 Select the outputs only by ticking Capacity Results: 
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 The tabular outputs enable the user to look at stress profiles and specific values for the pile 

as shown below: 

 

 The user can determine which limiting criterion applies to different lengths of pile by using 

the key provided in the Tabular Output: 
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1.2.2.2 Exporting Tabular Results 

 Select File > Export Results 

 

 Save the file as Tutorial 1 Exercise 1.csv to export the results to Excel 

1.2.2.3 Graphical Outputs 

 Double click on Graphical Output in the Output section of the Gateway 

 Using the excerpt from the User Manual shown below, plot the ultimate and design 

capacities for the pile and determine the length of pile required to support a load of 1000kN. 
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 The graphical output is shown below: 

 

 Compare the results for a 600mm and 700mm diameter pile 

 Re-run the analysis to view the impact of the other groundwater profile (phreatic surface at 

0mOD) to the pile capacity 
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1.2.2.4 Printing Graphical Outputs 

 Go to Tools > Preferences in the menu bar 

 

 Select appropriate options for the print output, including company information and logos. 

 Select File > Print Preview in the menu bar to check the output for printing 

Note: The user can also print the tabular output in this format 
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1.3 Pile Settlement Analysis 

1.3.1 Creating the input 

 Once opened, create a new file by clicking the ‘New File’ icon  on the top left of the 

program or clicking Ctrl + N 

 Fill the Titles and Units dialog box, outlining the Program is carrying out a Pile Settlement 

Analysis. 

 Double click on Settlement Data in the Gateway. 

 Input the following: 

 

Note: the excerpt from the manual outlines the definition for the different inputs and the user 

must read these before moving on. 
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Settlement data is enabled when settlement analysis is selected. 

Young’s Modulus of soil above toe level of pile and Young’s Modulus of soil below toe level 

of pile are average value representing the soil stiffness above and below the pile toe 

respectively. 

Poisson’s ratio is the average value from the different soil layers around the pile. 

Include effect of soil above pile base in base displacement calculation.  

For calculation of stiffness at the base node user can include/exclude effect of soil above pile 

base. 

Depth of rigid boundary – the pile is divided into the number of elements and Pile Stiffness is 

calculated for each element.  

Number of Increments – the load is applied in a number of equal increments, and  

Increment type – i.e. whether load alone is incremented, or applied displacement alone is 

incremented, or both of them are incremented.  

Increasing the increments helps to reduce any incompatibilities between relative displacements 

at the pile-soil interface, and the mobilized skin friction.  

The user may also specify the rate at which the results from various increments need to be 

printed, i.e. one in every 10 increments etc. Irrespective of the frequency specified, the program 

always prints the last increment.  

 

 Enter the same data for the following as the previous example: 

o Pile Properties 

o Material Properties 

o Soil Profile 

o Groundwater Data 

Note: You can copy and paste between tables in different pile analysis files. 

 Double click on Applied loads and displacements in the Gateway Menu 

Input a 1500kN load 

Question: At what loads will the pile stresses be presented in the output? 
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 Double click on Displacement Radii in the Gateway Menu  

 Input displacement radii at:  

o 0.3m 

o 1m 

o 2m 

Question: Why has a radii of 0.3m been chosen? 

1.3.2 Analysis and Outputs 

 Prior to analysis, check all inputs and save the file 

 Click on the analyse button  to carry out the analysis 

 The solution progress window will automatically appear and the analysis will run. 

1.3.3 Tabular Outputs 

The program will give the user the option to view tabular inputs and outputs. 

 Select the Settlement outputs only 
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1.3.4 Graphical Outputs 

A number of different options are available. Use the definitions below to produce two graphs 

outlined. 

Settlement 

 

1 Pile displacement and Soil displacement at 0.3m for a 20m long pile with 500kN load acting 

2 Limiting shaft skin friction, shaft skin friction and pile stress for a 25m long pile with 700kN 

load acting 
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The expected outputs are shown below: 
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Section 2  

Step by Step Tutorial 2 

Oasys Alp – Lateral Pile Capacity  

Objectives 

By the end of the session the user should be able to: 

 Navigate the Alp Interface 

 Use the Alp Wizard and Gateway 

 Run an analysis 

 Navigate the Graphical Output 

 Create simple graphs 

 Export tabular outputs for further analysis 
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2.1 Components of the User Interface 

The principal components of Alp's user interface are the Gateway, Table Views, Graphical Output, 

Tabular Output, toolbars, menus and input dialogs. These are illustrated below. 
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2.2 Creating the input 

 Once opened, create a new file by clicking the ‘New File’ icon  on the top left of the 

program  or clicking Ctrl + N 

 Fill the Titles and Units dialog box: 

 

Hint: Should the user need to change the Units, they should do so at this point or by double 

clicking on Units in the Gateway. 
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 Select the default options for the General Data box. 

 

 (Note: The user will have the opportunity change the Soil Model if required on leaving the 

wizard via the Gateway menu) 

 In the Pile and Soil Data box, input the parameters for the following, keeping the rest of the 

options for Soil Properties and Node Generation Control Parameters as default: 

o Soil top  0mOD 

 

o Pile top  0mOD 

o Pile bottom -13mOD 

o Pile diameter 0.6m 

o Pile EI  70 000 kNm2 

 

o Force  50kN at -1mOD 

o Moment -150kN at -1mOD 

 

o Groundwater -2mOD 
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 Double click on General Data in the Gateway.  

 Select the Generated P-Y curve option 

 

 Double click on Soil Data in the Gateway menu 

 Enter the properties outlined below for the following stratigraphy: 

 

o Soft Clay 0mOD 

o Stiff Clay -3mOD 

o Sand (API 18) -8mOD 

Use the User Manual to determine the E50 values-which Section have they been derived from 

and what do the curves look like? 
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 Double click on Restraints in the Gateway menu 

 Input a rotational restraint at 0mOD with a stiffness of 100 kN m/radian 

 Double click on Sections in the Gateway menu 

 Select Generated in the Input Type column 

 

 The Wizard will appear. Name the section Pile with Reinforcement. 

 

 Click on the Profile button in the Wizard and choose a Circular section with 600mm diameter. 

 Click on the Reinforcement button. 
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 The Section Concrete/Reinforcement Definition Box will appear. Click on the Add button. 

 In the General Reinforcement box, select the following options for the reinforcement bars: 

 

 

 Now click on OK and exit the Section Wizard.  
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2.3 Analysis and Outputs 

 Prior to analysis, check all inputs and save the file 

 Click on the analyse button to carry out the analysis 

 The solution progress window will automatically appear and the analysis will run. 

2.3.1 Tabular Outputs 

The program will give the user the option to view tabular inputs and outputs. 

 View the tabular output. 

Question: What is load increment? 

 Export the tabular output 
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2.3.2 Graphical Outputs 

 Double click on Graphical Output in the Gateway 

 

 Use the following icons to determine the maximum bending moment and effective length of 

the pile: 
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 Zoom into a section of the pile between -8mOD and -10mOD and unzoom 

Hint: To zoom, right left click and draw a box. To unzoom, use the unzoom icon 

 Check your results with the tabular results 

Question: Go back to General Data and increase the number of increments. How does it change 

your calculation? 
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Section 3  

Step by Step Tutorial 3  

Oasys AdSec –Section Analysis  

Objectives 

By the end of the session the user should be able to: 

 Navigate the AdSec Interface 

 Use the Alp Wizard and Gateway 

 Run an analysis 

 Navigate the Graphical Output 

 Create simple graphs and plot load cases 

 Understand the difference between Serviceability and Ultimate Limit State Calculations 
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3.1 Input 

3.1.1 Creating the Section 

 Once opened, the program start up screen will give a number of options. 

 Choose to Create a New Section. 

 
 

 Complete the Titles and Units section of the Wizard. 

 In the Design Option section, choose Eurocode 2 
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Note: The user can click on the Units button if you wish to change from SI Units  
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 In the Definition section of the Wizard, name the section appropriately and choose an 

Aggregate Size of 20mm. 

 
 

 Click on the Section button to open the Section Wizard.  

 Choose a circular section with 600mm diameter. 

 In the Reinforcement section of the wizard, click on the Template button. 
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 In the Template Definition box, choose Column Arrangement. 

 In the Links and Cover box, choose the following options: 
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 Finally, in the Circular/Elliptical Reinforcement section of the wizard, choose the following 

options: 
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3.1.2 Applying the Load Cases 

 Once the User exits the Wizard, they can view the Section and the Gateway: 

 

Note: Using the Material Properties section of the Gateway, the User can amend standard 

properties and apply these to their section if the options offered are not sufficient) 

 Expand Loads in the General tab of the Gateway.  

 Double click on Loading and input the following loads: 
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 Double click on Analysis Cases in the Gateway and input the following cases: 

Ultimate Limit State Case 

 

 

Servicability Limit State Case 
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3.2 Analysis and Outputs 

 Prior to analysis, check all inputs and save the file 

3.2.1 Load Moment Curve 

 Click on the N-M Chart Icon   

 Plot the N-M Chart 

 Click on the Additional chart Points icon  

 Use the Load Point button to plot the specified loads on the chart 

Note: Which load case is likely to cause the most cracking and why? Stop to discuss with the 

trainer 
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3.2.2 SLS Loads 

 Click on the SLS Loads icon. 

 Select all load cases and continue 

 Choose to view General Results and Crack Results 

 

Note: Look carefully at the results. Have the results converged successfully? Stop and discuss 

with the trainer 

 View Material and Reinforcement strains and stresses. 

 View crack widths. 

Question: Do the results correspond with the predictions made from the N-M chart? 

 Click on Section View to view the section.  

 Choose Analysis Case 2 in the Section View window. The user will be able to view where 

cracking is most likely to occur. 
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  Click on the Label icon  to show strains on the section for SLS Load Case 2 

 

3.2.3 ULS Loads 

 Use the ULS Load and ULS Strength icons. 

 How do the Stresses/Strains compare between the two results sets and why? Stop to discuss 

with your trainer. 
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Section 4  

Step by step Tutorial 4 

Oasys ADC –Section Analysis  

 

Objectives 

By the end of the session the user should be able to: 

 Navigate the ADC Interface 

 Use the ADC Wizard and Gateway 

 Run an analysis 

 Navigate the Graphical Output 

 Create simple graphs  
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4.1 Input 

 Once opened, the program start up screen will give a number of options. 

Choose to Create a New Section. 

 

 

 

 Complete the Titles and Units section of the Wizard. 
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 In the Program Option section, choose Column Design and the Eurocode 2 Design Code 

 

 

 

 

Note: The user can click on the Units button if you wish to change from SI Units 
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 In the Definition section of the Wizard, name the section appropriately and choose an 

Aggregate Size of 20mm. 

 

 

 

Click on the Section button to open the Section Wizard.  

 

Choose a circular section with 600mm diameter. 

 

Note: Click on the Concrete and Reinforcement options to see what is offered by the program 
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 In the Slenderness Details box, choose the following options for a 9m pile: 
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Apply the following Load Case (the moments are obtained from the Alp Output): 

Axial Force = 1000kN 

Top Moment (yy) = 200kNm 

Bottom Moment (yy) = 0kNm 
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Finally, in the Reinforcement section, the Arrangement and Cover need to be specified: 
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 Click on the Arrangement box.  

Click on the Standard box to select the number of bars per ring. 

 

 

 Click on the Cover box.  

Input the cover of 75mm. 

 

 

Note: Click the Code Cover box to see what the requirement is of the code you have specified 
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4.2 Analysis and Results 

 Now that all the Data is specified in the Reinforcement section, click on the Finish button 
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 The following box will appear, checking if you are happy with the number of sections. 

Click OK to proceed with the analysis. 
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 The Graphic View will appear, showing the acceptable reinforcement: 

  

 Click on the Design icon to run the analysis for the load case specified 
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 The following Graphical View will appear.  

Toggle through the different cases by pressing the + button to see the results. 
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4.2.1 Tabular Outputs 

 

 Click on the Output View icon  

 Select the following options in the Column Output Settings window to view the sections with 

adequate capacity for the load case specified in order of area of reinforcement: 

 

 

 

 View the Tabular Output results 

Scroll to the Column Summary Results to view the section with the lowest reinforcement 

area with adequate capacity 
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4.2.2 Plotting Charts 

 

 Click on the N/M Chart Icon   

 Choose the appropriate section to plot and view the results, noting the load case within the 

envelope 

 Click on the Myy/Mzz Chart Icon  

 Choose the appropriate section to plot and view the results, noting the load case within the 

envelope 
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Appendix 

EC7 – UK SAMPLE CALCULATION IN PILE 

The following example has been based on the design example given in “Design of pile 

foundations following Eurocode 7” by R. Frank. The final analysis file is also available in the 

Sample Files provided with the program. 

Pile Geometry: 

Solid circular pile with diameter 600 mm. The pile is “driven”. 

Soil Data: 

Sand layer with following properties: 

Density = 21 kN/m3 

Angle of internal friction = 35 degrees 

SPT N = 25  

Based on SPT, following values are assumed: 

End bearing stress, qb = 1370 kPa 

Skin friction stress, qs = 70 kPa 

These values are assumed to be uniform throughout the layer. 

Groundwater Data: 

GWT is located at a depth of 2 m below the ground level. 

Load Data: 

Characteristic permanent load Gk = 1200 kN 

Characteristic variable load Qk = 200 kN 
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Design Code: 

EC7 (United Kingdom) 

Following data need to be entered in the Pile data file: 

1 Analysis Options 

2 Capacity Data (for selecting design code) 

3 Pile Properties 

4 Materials 

5 Soil Profiles  

6 Groundwater  

7 Soil –profile Groundwater Map 

8 Applied Loads &  Displacements 

Each of the preceding items are explained in detail in the following sections: 

Analysis Options: 

This and other data modules can be invoked by clicking the relevant item in the Gateway: 
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Analysis type: 

In this example, only capacity calculations are carried out. Hence, only “Capacity” check box 

is checked. 

Effective Stresses: 

The program will be calculating the effective stresses, as opposed to user specifying the 

same. Hence, “Calculated” radio button is selected. 

Datum information: 

The data corresponding to soil layers, groundwater etc. is based on depth. Hence, “depth 

below ground level” is selected. 
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Capacity Data: 

Selecting this item in the Gateway brings up a wizard. To enable EC7 calculations, “Code 

based” option should be selected in the first page. 

Then, “EC7 (U.K. National Annex)” should be selected in the “Country Code” drop down box. 
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Then, the following page is shown on clicking “Next” 

 

It can be seen that only DA1 design approach is allowed, as is the case with U.K. national 

annex. 

The pile type should be specified as “driven” as per the data given for this example. 

The “Model factor” is read only. This is set to 1.4 by default. 

The pile type should be specified as “driven” as per the data given for this example. The 

“Model factor” is read only. This is set to 1.4 by default. 

However, if the user specifies that the resistance is verified by maintained load test taken to 

calculated, unfactored ultimate resistance by clicking the relevant check box, then the model 

factor is set to 1.2. 

The user also needs to verify whether explicit verification of SLS is carried out, by checking 

the relevant check box. This selection influences the R4 resistance factors as per Table 

A.NA.6 in U.K. national annex. 

The A1 and A2 partial factors on negative skin friction would be used for calculating the 

factored load due to negative skin friction, which is treated as an unfavourable action. The 

users may refer to A.3.1. section in UK national annex for guidance on these factors. These 

values can be ignored if there is no negative skin friction in the model. 

Clicking on the last check box in this page allows the user to see the results from both the 

combinations of DA1. 

Clicking on “Finish” closes the wizard and saves the code specific data. 
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Pile Properties: 

The pile geometry needs to be specified in the wizard invoked by selecting the relevant item 

in the Gateway: 

 

For the given model, “Solid circular” and “Without under-ream” options need to be selected.  

The “Young’s modulus” is not relevant to capacity calculations. Hence, leave the default 

value as it is. 

 

Once this data is entered, the user can specify the range of pile lengths for which capacity 

calculations need to be carried out.  

For this model, the range of pile lengths from 10m to 25m is suggested with an increment of 

1m.  

Also, since basement piles are not being modelled, “Depth of pile top below top of highest 

soil layer” needs to be set to zero as shown. 
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Next, the dimensions of a range of piles needs to be specified. 

 

In this model, we are interested in the capacity of only 600 mm diameter pile. Hence, only 

one entry is given. 

Clicking on “Finish” closes the wizard and saves the “Pile Properties” data. 
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Material Properties – Drained materials: 

In this model, there is only one drained material - Sand. The following data for the same 

needs to be entered in the “Undrained Materials” table by invoking the same from the 

Gateway. 

As the material tables are wide, it is suggested to enter the data directly in the “General”, 

“Friction” and “End Bearing” worksheets, instead of using the “All” worksheet. 
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In the “Friction” and “Bearing” worksheets, the user needs to select the “qs –specified” and 

“qb-specified” options, and enter the relevant values respectively as shown.  

The fields M1 and M2 correspond to the material factor sets. In EC7 (U.K.), all the M1 factors 

are always 1.0. Hence the fields are not editable. 

The field M2 may need to be explicitly entered by the user only in some circumstances. For 

example, DA1 C2 uses M2 factors to calculate the unfavourable Geo actions – which 

translates to negative skin friction for this program. However, the code only specifies M2 

factors for  

 Angle of shearing resistance,  

 Effective cohesion, 

 Undrained shear strength, and 

 Unconfined strength. 

The user need not explicitly enter the material factors if the skin friction and end-bearing 

values are solely computed on the basis of the above 4 parameters. However, if the user 

directly specifies qs, Nc, Nq or qb, then the program does not know the theory/formula 

which has been used in computing the same. In these cases, the program uses the material 

factors specified by the user in the tables above, to derive the “material factored” 

unfavourable geotechnical actions. 

For this example, however, as there is no negative skin friction involved, these factors can be 

left at the default value of 1.0. 
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Soil Profiles : 

The user then has to define the soil profiles. Each soil profile is a collection of material 

layers. 

The user can specify multiple soil profiles, particularly if he is using the “Model Pile” 

procedure”. 

However, for EC7 (U.K.) national annex, the program only uses the “Alternative procedure”. 

Hence, the user would be entering only one soil profile “S1” as shown: 

 

The user can enter multiple soil profiles for the “Alternative approach” also. In this case, the 

program calculates design resistance of pile in each of these soil profiles independently. 
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Groundwater: 

The user can specify the groundwater tables in the model in these worksheets.  

 

 In this particular example, there is only one soil profile and one ground water table. The 

same is entered as shown. 

If the user wants to model perched groundwater in a soil profile, he can use multiple data 

points to model the pore-pressure in the soil profile. In this case, the pore pressure 

distribution will not be hydrostatic. 
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Soil –profile Groundwater Map: 

This table is really used to associate a particular groundwater table to a particular soil 

profile. 

 

IMPORTANT: By default, no groundwater table is associated to the soil profiles created by 

the user. Hence, it is important to explicitly enter the data in this table when groundwater is 

present in a soil profile. 

Applied Loads & Displacements: 

For the capacity part, the “Displacements” are not relevant. 

The following load data needs to be entered as shown: 

  

Fields A1 and A2 refer to the action factor sets in EC7 (U.K.) N.A.  
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For this model example, it is assumed that for  

Action factor set A1: 

Dead load factor = 1.35 

Live load factor = 1.50 

Action factor set A2: 

Dead load factor = 1.00 

Live load factor = 1.30 
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Analysis & Results: 

Once the data is input as shown above, the user can proceed for analysis by clicking the 

“Analyse” button as shown: 

 This brings up the Pre-Analysis check dialog giving any warnings or errors in the model. If there 

are no errors, the user can run the analysis by clicking the “Proceed” button. 

After completion of analysis, the following print selection dialog appears: 
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The user can select the data of interest to be shown/printed in the tabular output, which comes 

up after clicking the “OK” button above: 

 

 

The program prints the factored load and design resistance information at the pile lengths 

specified by the user. 
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Validation: 

 A short validation is given below for the pile length of 25 m: 

Unit end bearing stress = 1370 kPa 

Area of the pile base  = (PI/4)* (0.6)*(0.6) = 0.283 m
2
 

Ultimate end bearing capacity = 1370*0.283 = 387.36 kN 

Unit skin friction = 70kPa 

Length of pile = 25 m 

Ultimate skin friction capacity = PI*0.6*70*25 = 3298.67 kN 

DA1 C1 

“A1 + M1 + R1” 

Action set A1: 

Factored load = 1.35*1200 + 1.5*200 = 1920 kPa 

Partial factor combination: 

Design resistance = ((Ultimate shaft resistance/shaft factor) +  

        (Ultimate base resistance/base factor))/model factor 

     = (3298.67/1.0 + 387.6/1.0)/1.4  = 2632.88 kPa 

DA1 C2 

“A2 + M1 + R4” 

Action set A1: 

Factored load = 1.00*1200 + 1.3*200 = 1460 kPa 

Note: R4 factor set is based on “No explicit SLS verification” 

Partial factor combination: 

Design resistance (Partial Factors) = ((Ultimate shaft resistance/shaft factor) +  

        (Ultimate base resistance/base factor))/model factor 

     = (3298.67/1.5 + 387.6/1.7)/1.4  = 1733.65 kPa 

Design capacity is the minimum from all the 4 cases above. 

Design capacity is the minimum from all the 2 cases above. 

 

Hence, the design capacity is 1733.65 kN, and the governing combination is DA1 C2. The 

corresponding factored load is 1460 kN. 

 


